Excel: Functions
Objectives
The aim of this course is to show you how to:

• Use functions to create formulas easily.
• Calculate functions with the AutoSum feature.
• Manipulate formulas within the Excel worksheet.

The software described is Microsoft Excel 2002 running on Windows XP.

Prerequisites
You should have a working knowledge of Microsoft Excel, including how to enter data, work with cells and ranges, and navigate a worksheet. You should also be familiar with the Windows XP desktop and with general concepts of manipulating windows such as menus, scrollbars and dialog boxes.

Key:
Caution — 🚇
Cool Tip — 🌞
Please Note — 🛡
Hands-On Activity — 🤸
# Table of Contents

1. An Introduction to Formulas in Microsoft Excel
   - A. The Components of an Excel Formula
   - B. Cell References in Formulas
   - C. Entering Formulas

2. An Introduction to Functions in Microsoft Excel
   - A. The Components of an Excel Function
   - B. Using the AutoSum Feature
   - C. Entering Basic Functions
   - D. Inserting Functions

3. Working with Formulas in Microsoft Excel
   - A. Relative vs. Absolute Cell Referencing
   - B. Copying Formulas
   - C. Editing Formulas
   - D. Making Sense of Error Messages

4. More Useful Functions
   - A. IF
   - B. PMT
   - C. DATE
   - D. CONCATENATE
   - E. UPPER, LOWER, PROPER

---

Excel: Functions
An Introduction to Formulas in Microsoft Excel

✓ The Components of an Excel Formula
✓ Order of Operations
✓ Use of Parentheses
✓ Cell References in Formulas
✓ Entering Formulas
✓ The Formula Bar
✓ Constructing Formulas with the Point Method
The distinguishing feature of a spreadsheet program such as Microsoft Excel is that it allows you to create mathematical formulas and execute functions. Using formulas and functions in Excel will save you time in calculating data. Excel will automatically update formulas whenever you change the numbers in your worksheet.

A formula is a set of instructions that you enter in a cell to perform calculations on values entered into the cells of a worksheet. Formulas consist of the addresses of the cells containing the values and the appropriate mathematical operators.

All formulas include three key elements:

1. An equal sign ( = ) to begin the formula.
2. The cell references or values you wish to include in the calculation.
3. The mathematical operator(s) to be used in the calculation.

Formulas begin with an equal sign ( = ). The equal sign prevents Excel from interpreting the formula as text, since cell addresses begin with letters. The formula then includes the values to be calculated with appropriate mathematical operators placed in between. For example, to add the values in cells A1 and A2, you would type the formula “=A1+A2”.

Values in a formula can be:
- A constant value (120)
- A cell (B2)
- A range of cells (B2:B10)
- A label or a name (FirstQuarterSales)
- A worksheet function (SUM)

Mathematical operators that can be used in an Excel formula are:
- Plus sign for addition.
- Minus sign for subtraction.
- Asterisk for multiplication.
- Front slash for division.
- Caret symbol for exponents.
- Open and close parentheses to group computation instructions.
Order of Operations

Excel calculates a formula from left to right. When more than one mathematical operator appears in a formula, Excel calculates according to the standard mathematical order of operations. This order determines which operations are carried out first.

The table below details the mathematical order of operations.

<table>
<thead>
<tr>
<th>Order</th>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st</td>
<td>Parentheses</td>
<td>Computations enclosed in parentheses are performed first, no matter where they appear in the formula.</td>
</tr>
<tr>
<td>2nd</td>
<td>Exponents</td>
<td>Computations involving exponents are performed second.</td>
</tr>
<tr>
<td>3rd</td>
<td>Multiplication and Division</td>
<td>Excel performs these operations next. Because they are equal with regard to the order in which Excel performs them, Excel performs them in the order in which it encounters them (from left to right).</td>
</tr>
<tr>
<td>4th</td>
<td>Addition and Subtraction</td>
<td>Excel performs these operations last. Excel also performs them in the order in which it encounters them (from left to right).</td>
</tr>
</tbody>
</table>

Use of Parentheses

To change the order of evaluation, enclose in parentheses the part of the formula to be calculated first. See how the use of parentheses changes the outcome of the formula below:

\[=5+2*3\]  
This formula produces “11” because Excel calculates multiplication before addition. The formula multiplies 2 by 3 and then adds 5 to the result.

\[=(5+2)*3\]  
In contrast, if you use parentheses to change the order of operations, Excel first adds 5 and 2 together and then multiplies the result by 3 to produce “21.”

Examples of formulas:

\[=5+2*3\]
\[=A3*(B3-C3)\]
\[=A3+B3+C3\]
\[=A3/B3\]
\[=(B3/5)+C3\]
\[=(FirstQuarterSales)*4\]
A reference identifies a cell or a range of cells on a worksheet and tells Excel where to look for the data you want to use in a formula. With references, you can use data contained in different parts of a worksheet in one formula or use the value from one cell in several formulas. You can also refer to cells on the other sheets in the same workbook, and to other workbooks.

By default, Excel uses the A1 reference style, which refers to columns with letters and refers to rows with numbers. These letters and numbers are called row and column headings. To refer to a cell, enter the column letter followed by the row number. For example, “B2” refers to the cell at the intersection of column B and row 2.

<table>
<thead>
<tr>
<th>To refer to:</th>
<th>Use:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The cell in column A and row 10</td>
<td>A10</td>
</tr>
<tr>
<td>The range of cells in column A and rows 10 through 20</td>
<td>A10:A20</td>
</tr>
<tr>
<td>The range of cells in row 15 and columns B through E</td>
<td>B15:E15</td>
</tr>
<tr>
<td>All cells in row 5</td>
<td>5:5</td>
</tr>
<tr>
<td>All cells in rows 5 through 10</td>
<td>5:10</td>
</tr>
<tr>
<td>All cells in column H</td>
<td>H:H</td>
</tr>
<tr>
<td>All cells in columns H through J</td>
<td>H:J</td>
</tr>
<tr>
<td>The range of cells in columns A through E and rows 10 through 20</td>
<td>A10:E20</td>
</tr>
</tbody>
</table>

Formulas containing **constant values** will produce a result that will never change. The formula “=3*4” produces the result “12”.

A formula containing **cell references** produces a result that may change if the data in those cells changes. The formula “=B2+C2” will produce a result based upon the values in cells B2 and C2.
Reference to Another Worksheet

You may want to use the value from a cell in another worksheet within the same workbook in a formula. In the following example, the Average worksheet function calculates the average value for the range B1:B10 on the worksheet named Marketing in the same workbook. Note that the name of the worksheet and an exclamation point precede the cell reference.

Reference to Another Workbook

A link is a reference to another workbook. Linking is especially useful when it is not practical to keep large worksheets together in the same workbook. Formulas with links to other workbooks are displayed in two ways, depending on whether the source workbook, the one workbook that supplies data to a formula, is open or closed.

When the source is open, the link includes the workbook name in square brackets, followed by the worksheet name, an exclamation point ( ! ), and the cells that the formula depends on. For example, the following formula adds the cells C10:C25 from the workbook named Budget.xls.

\[ \text{=SUM([Budget.xls]Annual!C10:C25)} \]

When the source is not open, the link includes the entire path.

\[ \text{=SUM('C:\Reports\[Budget.xls]Annual'!C10:C25)} \]

Formulas that link to a defined name (a word or string of characters that represents a cell, range of cells, formula, or constant value) in another workbook use the workbook name followed by an exclamation point ( ! ), and the name. For example, the following formula adds the cells in the range named Sales from the workbook named Budget.xls.

\[ \text{=SUM(Budget!Sales)} \]

If the name of the other worksheet or workbook contains nonalphabetic characters you must enclose the name (or the path) within single quotation marks.
I-C: Entering Formulas

Formulas are used to obtain answers based on mathematical equations that you design. Formulas can be as simple as “=2+2” or as complex as calculating the depreciation of fixed assets. When creating formulas, you may use actual values, cell addresses, or a combination of the two.

When you enter a formula into a cell, you can either type the cell addresses or use the mouse to select the cells and allow Excel to enter the cell addresses into the formula automatically.

The steps for entering a formula are outlined below:
1. Click the cell in which you want the result of the formula to display.
2. Type the equal sign [=].
3. Enter the appropriate constant values and/or cell references along with the mathematical symbol(s) for performing your calculation(s).
4. Press [Enter].

Formulas are entered in the cell where you want the result to appear. Once the formula has been entered:
- The result will be displayed in the current cell
- The formula will be displayed in the Formula bar
After a formula is entered into the cell, the calculation executes immediately and the formula itself is visible in the Formula bar (Refer to Figure 1-1). See the example in Figure 1-1 to view the formula for calculating the sub total for a number of textbooks. The formula multiplies the quantity and price of each textbook and adds the subtotal for each book.

You will find that you cannot see the true contents of a cell containing a formula just by looking at it. What you see in the cell is the result based on the formula entered. In order to view the formula, you must select the cell in which it is stored and then view the formula contents in the Formula bar.
**Activity 1 - 1**

**Enter a Formula Using the Keyboard Only**

You have enrolled in two courses this semester. You want to track your course expenses in an Excel worksheet.

In this activity, you will write a formula to subtotal the text book expenses for the Writing Creative Nonfiction course.

1. Open the file Formulas_Practice.xls on the desktop.
2. Select the worksheet *Courses*.
3. Select cell C5.
4. Type the following formula: \(=C2+C3+C4\)
5. Press [Enter].

![Figure 1-2: Subtotal Before and After Pressing Enter](image)

*Figure 1-2: Subtotal Before and After Pressing Enter*
Constructing Formulas with the Point Method

Sometimes, not all of the cells you wish to reference in a formula are visible in the Excel window. In this case, it is more accurate to use the mouse to select cells while creating a formula. You only need to type the equal sign (=) to start the formula and type each of the other mathematical operators in the formula.

The key to the point method is to point and click the cells to be included and to type the operators where appropriate. The following example provides instructions for a simple addition of two cells “=cell1+cell2” using the point method.

1. Click the cell in which you want to enter the formula.
2. To start the formula, press [=].
3. Point and click on the first cell to be added.
4. Press [+].
5. Point and click on the second cell to be added.
6. Press [Enter].

Instead of pressing [Enter] to complete formulas in Excel, you can click the green check mark in the Formula bar [✓].
Activity 1 - 2
Enter a Formula Using the Point Method

Now you will write a formula to subtotal the text book expenses for the Techniques of Successful Writing course. This time you will use the point method instead of typing the cell references.

1. Select cell **C10**.
2. Press `[=]`.
3. Point and click on cell **C8**.
4. Press `[+]`.
5. Point and click on cell **C9**.
6. Press [✓] on the Formula bar to enter the formula.

![Figure 1-3: Subtotal Before and After Entering](image)
An Introduction to Functions in Microsoft Excel

- The Components of an Excel Function
- The AutoSum Feature
- Entering Basic Functions
- The AutoCalculate Feature
- Inserting Functions
- Searching for Functions
- Getting Help with Functions
2-A : The Components of an Excel Function

General mathematical built-in functions are provided with Microsoft Excel to carry out calculations on data within the worksheet and can take the place of certain types of formulas. Functions can be a more efficient way of performing mathematical operations.

A function is a built-in Excel formula. You can use functions to simplify the process of entering formulas. For example, if you wanted to add the values of cells D1 through D10, you would type the formula “=D1+D2+D3+D4+D5+D6+D7+D8+D9+D10”. A shorter way would be to use the SUM function and simply type “=SUM(D1:D10)”.

All functions contain the same syntax:

1. An equal sign ( = ) at the beginning.
2. The **Function name** follows next.
3. The **Arguments** (the cell references to be used in the calculation enclosed in parentheses) come last.

Microsoft Excel provides over 200 built-in formulas called functions. You can use a function by itself or in conjunction with other formulas or functions. Some of the most commonly used functions are described in the table below:

<table>
<thead>
<tr>
<th>Function</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sum</td>
<td>=SUM(A4:A10)</td>
<td>Adds the values in cells A4 through A10.</td>
</tr>
<tr>
<td>Average</td>
<td>= AVERAGE(B1:B12)</td>
<td>Calculates the mean average of the values in cells B1 through B12.</td>
</tr>
<tr>
<td>Minimum</td>
<td>=MIN(C5:C20)</td>
<td>Finds the minimum value of the values in cells C5 through C20.</td>
</tr>
<tr>
<td>Maximum</td>
<td>=MAX(D1:D10)</td>
<td>Finds the maximum value of the values in cells D1 through D10.</td>
</tr>
<tr>
<td>Count</td>
<td>=COUNT(A2:A18)</td>
<td>Finds the number of numeric entries in cells A2 through A18.</td>
</tr>
</tbody>
</table>
2-B: Using the AutoSum Feature

One of the most commonly used functions in Microsoft Excel is the SUM function, which calculates the total of the values in a range of cells. Using this function is easier than typing a formula and each individual cell address.

Since the SUM function is used frequently, there is an AutoSum button on the Standard toolbar that enters the formula in the active cell for you. The AutoSum button is an easy way to sum values in a row or column of a worksheet.

When you click the AutoSum button, a suggested range for the function is selected. This suggested range can be changed. If you click the AutoSum button at the end of a row, the row of values to the left of the active cell is selected. If you click the AutoSum button at the bottom of a column, the column of values above the active cell is selected. If there are values both above and to the left of the active cell, the column of values above the active cell is selected.

Excel’s AutoSum feature allows you to quickly create sums, and other functions, without typing any function syntax.

To calculate a sum using AutoSum:
1. Click on the cell into which you want to calculate a sum.
2. Click the AutoSum button on the Standard toolbar.
3. Excel will highlight a range that it assumes you would like to sum.
   - If Excel has chosen the correct range, press [Enter].
   - If Excel has chosen the incorrect range, simply click and highlight the correct range, and then press [Enter].
4. Excel calculates and enters the sum.

To access other functions using AutoSum:
1. Click on the cell into which you want to calculate a sum.
2. Click the AutoSum drop-down arrow button on the Standard toolbar.
3. Select the function you want to use from the list of commonly used functions (or select More Functions to search for additional functions).
4. Excel will highlight a range that it assumes you would like to use in your calculation.
   - If Excel has chosen the correct range, press [Enter].
   - If Excel has chosen the incorrect range, simply click and highlight the correct range, and then press [Enter].
5. Excel calculates and enters the result.
Activity 2 - 1
Calculate a Sum Using the AutoSum Button

One of your New Year’s resolutions was to keep better accounting records for your personal financial budget. In addition to entering your course expenses in Microsoft Excel, you will also be tracking your bill payments.

In this activity, you will total the amount paid for the months of January through June for each of your Utilities using the AutoSum button.

1. Select the worksheet Bills in the Formulas_Practice file on the Desktop.
2. Select cell I2 as the location for the Electric total.
3. Click the AutoSum button Σ on the Standard toolbar.
4. Excel highlights the range C2:H2 (Refer to Figure 2-1).
5. Since this is the correct range, press [Enter].
6. Excel calculates and enters the total $615.00 for Electric.
7. Repeat these steps to use AutoSum to calculate the total for Phone in cell I3.

When you are finished, your worksheet should look like Figure 2-2.
8. Select cell I4 as the location for the Cable total.
9. Click the AutoSum button on the Standard toolbar.
10. Excel highlights the range I2:I3, which is NOT the range you wish to sum.
11. Click and highlight the correct range C4:H4 (Refer to Figure 2-3).
12. Press [Enter].
13. Excel calculates and enters the total $240.00 for Cable.
14. Repeat these steps to use AutoSum to calculate the total for Water in cell I5.

When you are finished, your worksheet should look like Figure 2-4.
2-C : Entering Basic Functions

There are multiple ways you can create a function. You can insert functions manually (by typing them), or you can select from available functions using the Insert Function dialog box or the Functions List.

The steps for entering a function are outlined below:
1. Click the cell in which you want to display the results of the function.
2. Press [ = ].
3. Enter the Function Name into the cell by one of the methods described in the table below.
4. Select or enter the Function Arguments (cell references to be used in the calculation enclosed in parentheses).
5. Press [Enter].

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the Keyboard Only</td>
<td>Type the entire function directly into the cell.</td>
</tr>
<tr>
<td>Use the Keyboard and Mouse</td>
<td>Type the function name and the left parenthesis, use the mouse to select the range(s) as the argument(s), separating multiple arguments with commas, and type the right parenthesis.</td>
</tr>
<tr>
<td>Insert Function</td>
<td>Select Insert &gt; Function from the Menu bar to open the Insert Function dialog box and select from a list of all available functions.</td>
</tr>
<tr>
<td>AutoSum feature</td>
<td>Click the AutoSum drop-down arrow button located on the Standard toolbar to display a list of functions to select from.</td>
</tr>
<tr>
<td>Insert Function button</td>
<td>Click the Insert Function button located on the Formula bar to open the Insert Function dialog box and select from a list of all available functions.</td>
</tr>
</tbody>
</table>

Once you type [ = ] in a cell, the Functions List will become available for you to select functions from in the far left of the Formula bar.
To enter a function manually, you must first click in the cell in which you want the function to be placed, then type the formula as described in steps 1 through 6 below for each of the basic functions.

1. Press \(=\).
2. Type the function name [sum, average, min, max, count].
3. Press left parenthesis [ ( ].
4. Type the reference to the cells you wish to use in the calculation.
   - Press the colon [ : ] between the first and last cells in a range.
   - Press comma [ , ] if you are listing cells.
5. Press right parenthesis [ ) ].
6. Press [Enter]. Excel will calculate and enter the result in the cell.

For example, in Figure 2-5 below, Excel calculates the sum of the range of cells beginning with cell A3 and ending with cell D3. In Figure 2-6 below, Excel calculates the average of cells H13 and H15.

\[
\begin{align*}
\text{Figure 2-5: Calculate a Sum} & \quad =\text{sum}(A3:D3) \\
\text{Figure 2-6: Calculate an Average} & \quad =\text{average}(H13,H15)
\end{align*}
\]
Activity 2 - 2
Calculate an Average Manually Using the AVERAGE Function

You are considering purchasing a new car. In order to make an informed decision about what car to buy, you would like to calculate the average amount you spend monthly on gas and car maintenance for the car you currently own.

In this activity, you will find the average amount paid for gas for the months of January through June by entering the Average function manually.

1. Select the worksheet Bills in the Formulas_Practice file on the Desktop.
2. Type Average in cell J1 to title this column (Refer to Figure 2-7).

<table>
<thead>
<tr>
<th>H</th>
<th>I</th>
<th>J</th>
</tr>
</thead>
<tbody>
<tr>
<td>June</td>
<td>Total</td>
<td>Average</td>
</tr>
<tr>
<td>$ 95.00</td>
<td>$ 615.00</td>
<td></td>
</tr>
</tbody>
</table>

Figure 2-7: Average Column Title

3. Select cell J11 as the location for the Gas average.
4. Type the following function: =average(C11,D11,E11,F11,G11,H11)

<table>
<thead>
<tr>
<th>Gas</th>
<th>$ 40.00</th>
<th>$ 30.00</th>
<th>$ 20.00</th>
<th>$ 20.00</th>
<th>$ 15.00</th>
<th>$ 25.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintenance</td>
<td>$ -</td>
<td>$ 35.00</td>
<td>$ 150.00</td>
<td>$ -</td>
<td>$ -</td>
<td>$ 40.00</td>
</tr>
</tbody>
</table>

Figure 2-8: Average Gas Payments

5. Press [Enter].
6. Excel calculates and enters the average $25.00 for Gas.
To avoid typographical errors, it is a good idea to click and select the cells you wish to calculate instead of typing the function arguments directly into the formula. You can select one cell at a time or select a range of cells.

Instead of typing the cell reference, click and select the range of cells you wish to calculate. Excel will enter the cell reference for you in the formula.

Activity 2 - 3
Calculate an Average Using the AVERAGE Function

In this activity, you will find the average amount paid for car maintenance by entering the Average function manually. This time, however, you will use the mouse to select the range of cells for the months of January through June.

1. Select the worksheet Bills in the Formulas_Practice file on the Desktop.
2. Select cell J12 as the location for the Maintenance average.
3. Type the following function: =average(
4. Click and highlight the range C12:H12 (Refer to Figure 2-9).

If a cell in the range is empty, it is NOT included in calculating the average. If a cell in the range contains the number zero, it IS included in calculating the average.

5. Press [Enter].
The AutoCalculate Feature

The **AutoCalculate** feature is helpful when you want to spot-check your worksheet for accuracy. **AutoCalculate** performs a simple calculation on a selected range of cells without making you supply a formula. The results of the calculation appear on the Status bar in the lower right of the Excel worksheet window (Refer to Figure 2-10). These results are temporary and are not placed in the worksheet.

![Figure 2-10: AutoCalculate Box](image)

To use the AutoCalculate feature to find a sum:

1. Click and highlight the **range of cells** you want to sum.
2. View the **Status bar** to see the sum displayed in the lower right (Refer to Figure 2-11).

![Figure 2-11: AutoCalculate Sum](image)

By default, **AutoCalculate** displays the **SUM** of the values in the selected range. You can use **AutoCalculate** to do other things, such as calculate the average of a group of values, or count the number of entries in a selected range. Other functions are accessed by clicking the right mouse button on the **AutoCalculate** box located on the Status bar (Refer to Figure 2-12).
To change the calculation performed by AutoCalculate:

1. **Right-click** on the **AutoCalculate** box in the Status bar to access a shortcut menu.
2. Select the **function** from the menu that you would like to use (Refer to Figure 2-12).
3. Select the **range of cells** in the worksheet that you would like to calculate.
4. Excel performs the selected function for the selected range. View the **Status bar** to see the result.

![Figure 2-12: AutoCalculate Other Functions](image)

**It’s important to note that the AutoCalculate feature only displays a value. It is not entered permanently into the worksheet anywhere, and when you deselect the range, the value is gone.**
If you are not sure of the proper syntax of a formula, or you need help entering a formula, you can click the Insert Function button on the Formula bar for assistance. Once you click the Insert Function button, the Insert Function dialog box opens. The Insert Function dialog box allows you to select a function name and the appropriate arguments. Figure 2-13 and the table below describe the options available to you in the Insert Function dialog box.

**Figure 2-13: Insert Function Dialog Box**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>Search for a function</td>
</tr>
<tr>
<td>b</td>
<td>Select a category</td>
</tr>
<tr>
<td>c</td>
<td>Select a function</td>
</tr>
<tr>
<td>d</td>
<td>Help on this function</td>
</tr>
</tbody>
</table>
Determining what functions are available, what function you should be using, and what you need to include in the function can be easier with the Insert Function dialog box.

The Insert Function dialog box will display a listing of all functions or categories of functions available in Microsoft Excel. As you select a function, a sample of the function appears at the bottom of the dialog box. As you make your selection, the Function Arguments dialog box (Refer to Figure 2-14) will open, providing you with a text box into which you can insert the cell range for the formula.

To enter a function using the Insert Function button:
1. Select the cell you want to contain the function.
2. Click the Insert Function button on the Formula bar. The Insert Function dialog box opens (Refer to Figure 2-13).
3. Click the Or select a category drop-down arrow (Refer to Figure 2-13) and:
   - Select All to display a listing of all available Excel functions or
   - Select a more specific category based on the function you wish to use
4. From the Select a function list box (Refer to Figure 2-13), select the desired function.
   A description of the selected function appears beneath the Select a function list box as you highlight the function.
5. Click OK.
6. The **Function Arguments** dialog box appears (Refer to Figure 2-14).
7. In the **Number** text box (Refer to Figure 2-14), type the value and/or cell references to be used in the function.

   ![Tip]
   To hide the **Function Arguments** dialog box so you can select cell ranges with the mouse rather than type them, click the **Collapse** button. Once you have made your selection, click the **Restore** button to reopen the dialog box.

8. Click **OK**.
9. The **Function Arguments** dialog box closes. Excel calculates and enters the result in the cell.

---

**Activity 2 - 4**

**Calculate a Maximum Using the Insert Function Dialog Box**

Your best friend has heard you speaking with pride and excitement about the Excel worksheets you have created to maintain your personal expenses. He has asked that you help him create a few formulas in one of his company sales worksheets to calculate the highest and lowest sales totals for the first and second quarters.

In this activity, you will calculate the highest sales totals reported for Quarters 1 and 2 at Benjamin of Brussels Company.

1. Select the worksheet **Sales** in the **Formulas_Practice** file on the Desktop.
2. Select cell **D18** as the location for the **High** sales amount for Quarter 1.
3. Click the **Insert Function** button on the Formula bar.
4. In the **Search for a function** text box, type: **find the highest amount**
5. Click **Go**.
6. Click and highlight the function **MAX** in the **Select a function** list box.
Your **Insert Function** dialog box should look like Figure 2-15.

7. Click **OK**.
8. The **Function Arguments** dialog box opens.
9. Excel enters the range **D5:D17** (Refer to Figure 2-16).

10. Since this is the correct range, click **OK**.
11. Excel calculates the maximum and enters **$25,600.00** as the highest sales total for Quarter 1.
12. Select cell **E18** as the location for the **High** sales amount for Quarter 2.
13. Press `[=]`.
14. Click **MAX** on the **Function List** button on the far left of the Formula bar (Refer to Figure 2-17).

![Figure 2-17: Function List Button](image)

When you click the **Function List** drop-down arrow to the right of the **Function List** box, you can select from a list of the most commonly used functions, as well as open the **Insert Function** dialog box by selecting the **More Functions** option.

15. Since you have already selected the function, you are brought directly to the **Function Arguments** dialog box.
16. Excel enters the range **D18**, which is NOT the range you wish to calculate the maximum for.
17. Click the **Collapse** button to shrink the **Function Arguments** dialog box so you can navigate to the correct range on the Sales worksheet.
18. Click and highlight the correct range **E5:E15** (Refer to Figure 2-18).
19. Click the **Restore** button in the **Function Arguments** window to restore the **Function Arguments** dialog box to its full size.

20. Click **OK**.

21. Excel calculates the maximum and enters **$58,445.00** as the highest sales total for Quarter 2.

Your Qtr 1 and Qtr 2 columns should now look like Figure 2-19.

<table>
<thead>
<tr>
<th></th>
<th>Qtr 1</th>
<th>Qtr 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$14,815.00</td>
<td>$13,100.00</td>
</tr>
<tr>
<td></td>
<td>$24,500.00</td>
<td>$25,600.00</td>
</tr>
<tr>
<td></td>
<td>$20,900.00</td>
<td>$22,600.00</td>
</tr>
<tr>
<td></td>
<td>$15,900.00</td>
<td>$22,700.00</td>
</tr>
<tr>
<td></td>
<td>$25,000.00</td>
<td>$34,000.00</td>
</tr>
<tr>
<td></td>
<td>$24,110.00</td>
<td>$54,812.00</td>
</tr>
<tr>
<td></td>
<td>$25,600.00</td>
<td>$48,752.00</td>
</tr>
<tr>
<td></td>
<td>$22,600.00</td>
<td>$58,445.00</td>
</tr>
<tr>
<td></td>
<td>$22,700.00</td>
<td>$48,648.00</td>
</tr>
<tr>
<td></td>
<td>$23,300.00</td>
<td>$24,600.00</td>
</tr>
<tr>
<td></td>
<td>$23,800.00</td>
<td>$27,700.00</td>
</tr>
</tbody>
</table>

| High   | $25,600.00 | $58,445.00 |

*Figure 2-19: Quarter 1 and Quarter 2 Highest Sales*
Working with Formulas in Microsoft Excel

- Absolute vs. Relative Cell Referencing
- Using AutoFill to Copy Formulas
- Editing Formulas
- Deleting Formulas
- Showing All Formulas
Understanding relative and absolute cell referencing is essential when copying and moving formulas. It is important to make sure that they refer to the correct cells.

**Relative Referencing**
Calling cells by just their column and row labels (such as A1) is called relative referencing. When a formula contains relative referencing and it is copied from one cell to another, Excel does not create an exact copy of the formula. It will change cell addresses relative to the row and column they are moved to. If you copy the formula across rows or down columns, the reference automatically adjusts.

By default, new formulas use relative references. For example, if you copy a relative reference in cell B2 to cell B3, it automatically adjusts from =A1 to =A2.

![Relative Referencing](Figure 3-1: Relative Referencing)

To prevent this change, cells must be called by absolute referencing.
Absolute Referencing

An absolute cell reference in a formula, such as $A$1, always refers to a cell in a specific location. If the position of the cell that contains the formula changes, the absolute reference remains the same. If you copy the formula across rows or down columns, the absolute reference does not adjust.

To create an absolute reference, place dollar signs "$" within the cell addresses in the formula. For example:

<table>
<thead>
<tr>
<th>Formula</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$A1</td>
<td>As this formula is copied, it will always reference the contents of column A, but the row may vary if the formula is copied down to a different row.</td>
</tr>
<tr>
<td>A$1</td>
<td>As this formula is copied, it will always reference the contents of row 1, but the column may vary if the formula is copied across the spreadsheet.</td>
</tr>
<tr>
<td>$A$1</td>
<td>Regardless of where the formula is copied, it will always reference the contents of cell A1 in column A, row 1.</td>
</tr>
</tbody>
</table>

By default, new formulas use relative references, and you need to switch them to absolute references. For example, if you copy an absolute reference in cell B2 to cell B3, it stays the same in both cells =A$1.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>=A$1</td>
</tr>
<tr>
<td>3</td>
<td>=A$1</td>
</tr>
</tbody>
</table>

*Figure 3-2: Absolute Referencing*
3-A : Copying Formulas

As you work in Excel, you will often want to reuse formulas in different parts of the worksheet. This will save you time because you won’t have to retype them.

You can quickly and easily copy formulas into adjacent cells by using the AutoFill Handle (the small black square in the lower-right corner of the selection.

To copy a formula using AutoFill:

1. Click anywhere inside the cell that you want to copy to select it.
2. Rest the mouse pointer on the Fill Handle at the lower-right corner of the selected cell.
3. The mouse pointer will change to a solid cross.
4. Once the pointer has changed to a solid cross, click and hold the mouse button down and drag the Fill Handle to the adjoining cell(s) that you want to copy into.
5. Release the mouse button. Excel fills the cell(s) with the copied formula using relative referencing.

Example of AutoFill formula:

![Figure 3-3: AutoFill Commission Formula](image-url)
To copy a formula to a nonadjacent cell, use any of the copy/past functions in Excel:

**Standard toolbar buttons**

**Menu bar**

- Edit > Copy
- Edit > Paste

**Keyboard**

- [Ctrl] C
- [Ctrl] V

---

**Activity 3 - 1**  
**Use AutoFill to Copy a Formula**

Your best friend is so happy with the work you did on his Benjamin of Brussels Excel worksheet. He wonders if it would be a lot of trouble for you to calculate the remaining highest sales totals for Quarters 3 and 4.

In this activity, you will use AutoFill to quickly calculate the highest sales totals reported for Quarters 3 and 4 at Benjamin of Brussels Company.

1. Select the worksheet Sales in the Formulas_Practice file on the Desktop.
2. Select cell E18, which contains the formula you want to copy.
3. Rest the mouse pointer on the Fill Handle at the lower-right corner of cell E18. The mouse pointer will change to a solid cross (Refer to Figure 3-4).

![Figure 3-4: Fill Handle](image-url)
4. Once the pointer has changed to a solid cross, click and hold the mouse button down to drag the Fill Handle to the right across to cell G18 (Refer to Figure 3-5).

![Figure 3-5: Fill Handle](image)

5. Release the mouse button over cell G18. Excel fills the maximum formulas in cells H18 and G18 for Quarters 3 and 4 using relative referencing.

Your worksheet should now look like Figure 3-6.

![Figure 3-6: Highest Sales All Quarters](image)
3-C : Editing Formulas

After entering formulas in your worksheet, you may find that you need to make some changes to those formulas that you had originally created. When you enter or edit a formula in Microsoft Excel, cell references and the borders around the corresponding cells are color-coded to guide you (Refer to Figure 3-7).

To change cell references in a formula:

1. **Double-click** the cell that contains the formula you want to change. Microsoft Excel highlights each cell or range of cells with a different color.
2. Do one of the following:
   - To move a cell or range reference to a different cell or range: drag the color-coded border of the cell or range to the new cell or range.
   - To include more or fewer cells in a reference: drag a corner of the border.
   - In the formula, select the reference, and type a new one.
3. Press `Enter`.

Deleting Formulas

Deleting formulas can be much easier than creating them!

To delete a formula:

1. Click the cell that contains the formula.

Sometimes it can be helpful to see what cells in your worksheet contain formulas.

**To select cells that contain formulas:**

1. On the **Edit** menu, click **Go To**.
2. Click **Special**.
3. Click **Formulas**, and then select the check box next to the type of data you want to select.
3-D : Making Sense of Error Messages

When you enter an incorrect formula, operand, value, reference, etc., Excel displays an error value in the cell. Error values always begin with a pound sign ( # ). Below is a list of common errors:

- **#VALUE!** The cells used in the formula or function contains numbers that will not return a logical value amount. Recheck all the values you used in the formula.
- **#NAME!** Excel doesn’t understand the function name that is entered in the cell. Make certain that you used the correct name.
- **#DIV/0** The formula is attempting to divide by 0. Have you referenced a blank cell or range? Or deleted a value needed in the formula?

**Error Checking Smart Tag**

A smart tag 🚩 appears when you create a formula which Excel believes may be incorrect. The notification comes to you in the form of a green triangle in the corner of the cell that may contain the error. When you select the cell, the **Error Checking** button appears. Hover your mouse over the button to display a tool tip that describes the possible problem. Click the drop-down arrow next to the Error Checking button to display a list of options available to correct the potential problem.
More Useful Functions in Microsoft Excel

- IF Function
- PMT Function
- DATE Function
- CONCATENATE Function
The IF Function checks a condition that must be either true or false. If the condition is true, the function returns one value. If the condition is false, the function returns another value.

The function has three arguments:
1. The condition you want to check.
2. The value to return if the condition is true.
3. The value to return if the condition is false.

Syntax:

```
IF(logical_test,value_if_true,value_if_false)
```

**Logical_test** is any value or expression that can be evaluated to TRUE or FALSE. For example, A10=100 is a logical expression; if the value in cell A10 is equal to 100, the expression evaluates to TRUE. Otherwise, the expression evaluates to FALSE.

**Value_if_true** is the value that is returned if logical_test is TRUE. For example, if this argument is the text string "Within budget" and the logical_test argument evaluates to TRUE, then the IF function displays the text "Within budget". If logical_test is TRUE and value_if_true is blank, this argument returns 0 (zero). To display the word TRUE, use the logical value TRUE for this argument. Value_if_true can be another formula.

**Value_if_false** is the value that is returned if logical_test is FALSE. For example, if this argument is the text string "Over budget" and the logical_test argument evaluates to FALSE, then the IF function displays the text "Over budget". If logical_test is FALSE and value_if_false is omitted, (that is, after value_if_true, there is no comma), then the logical value FALSE is returned. If logical_test is FALSE and value_if_false is blank (that is, after value_if_true, there is a comma followed by the closing parenthesis), then the value 0 (zero) is returned. Value_if_false can be another formula.

<table>
<thead>
<tr>
<th>Formula</th>
<th>Description (Result)</th>
</tr>
</thead>
<tbody>
<tr>
<td>=IF(A2&lt;=100,&quot;Within budget&quot;,&quot;Over budget&quot;)</td>
<td>If the number above is less than or equal to 100, then the formula displays &quot;Within budget&quot;. Otherwise, the function displays &quot;Over budget&quot;</td>
</tr>
<tr>
<td>=IF(A2=100,SUM(B5:B15),&quot;&quot;)</td>
<td>If the number above is 100, then the range B5:B15 is calculated. Otherwise, empty text (&quot;&quot;&quot;) is returned ()</td>
</tr>
</tbody>
</table>
4-B : Using the PMT Function

The PMT Function calculates the payment for a loan based on constant payments and a constant interest rate.

Syntax:

\[
PMT(rate, nper, pv, fv, type)
\]

- **Rate** is the interest rate per period for the loan. (For example, use \(6\% / 4\) for quarterly payments at 6% APR.
- **Nper** is the total number of payments for the loan.
- **Pv** is the present value, or the total amount that a series of future payments is worth now; also known as the principal.
- **Fv** is the future value, or a cash balance you want to attain after the last payment is made. If \(fv\) is omitted, it is assumed to be 0 (zero), that is, the future value of a loan is 0.
- **Type** is the number 0 (zero) or 1 and indicates when payments are due.

Example: Calculating Loan Payments

\[
=PMT(5.75\%/12, 60, 19000)
\]

Use cell addresses instead of constant values for any of the payment arguments to do a “what if” scenario.
Using the DATE function returns the sequential serial number that represents a particular date. If the cell format was General before the function was entered, the result is formatted as a date.

Excel stores dates as sequential serial numbers so they can be used in calculations. By default, January 1, 1900 is serial number 1, and January 1, 2008 is serial number 39448 because it is 39,448 days after January 1, 1900. Excel for the Macintosh uses a different date system as its default.

Syntax:

\texttt{DATE(year,month,day)}

\textbf{Year} \hspace{1em} The year argument can be one to four digits. Microsoft Excel interprets the year argument according to the date system you are using. By default, Excel for Windows uses the 1900 date system; Excel for the Macintosh uses the 1904 date system.

\textbf{Month} \hspace{1em} is a number representing the month of the year. If month is greater than 12, month adds that number of months to the first month in the year specified. For example, \texttt{DATE(2008,14,2)} returns the serial number representing February 2, 2009.

\textbf{Day} \hspace{1em} is a number representing the day of the month. If day is greater than the number of days in the month specified, day adds that number of days to the first day in the month. For example, \texttt{DATE(2008,1,35)} returns the serial number representing February 4, 2008.
Excel offers a variety of different ways to include dates and times into your worksheets. Static and dynamic are two types of dates and times. Static dates and times will not change but dynamic dates and times will change as time progresses. Nevertheless, both static and dynamic dates and times are useful.

**Example: Inserting Dynamic Dates**

Dynamic dates are updated every time Excel recalculates, which is, by default, every time [Enter] is pressed. This is useful if you would like the current date to be displayed every time the worksheet is viewed or printed.

1. Select the cell in which you want the date to appear.
2. In the cell, type: =today()
3. Press [Enter].

The current date appears in the cell and will be updated every time Excel recalculates.

**Example: Inserting Static Dates**

Static dates are not updated. The date that is inserted into the cell is the date immediately after the command is entered into the cell. This can be used to enter the date when the worksheet has been created.

1. Select the cell in which you want the date to appear.
2. Press [Ctrl] and [;].

The current date appears in the cell and will not be updated.
Example: Calculate the Number of Days Between Two Dates

You do not have to use the DATE function, or any other function, to calculate the number of days between two dates. Use the subtraction (-) operator to do this.

![Figure 4-1: Calculate the Difference between two dates](image)

=\text{B2-A2}

Remember to change the Format for the “Days in between” cell to the Number format. Select Format > Cells and choose the Number Category.
The CONCATENATE function creates a text string by pulling data from specified fields. This function can join information such as first and last names, or names and scores, which are in separate fields. Up to 30 fields may be added together in this fashion.

Syntax:

```
CONCATENATE (text1, text2, ...)
```

- `text1, text2, ...` are 1 to 30 text items to be joined into a single text item. The text items can be text strings, numbers, or single-cell references.

To add supplementary text between fields, type the text in quotation marks. To add a space between fields, type `" "`.

**Example: Concatenate First and Last Names**

![Figure 4-2: Concatenate First and Last Names](image)

The `&` operator can be used instead of CONCATENATE to join text items.
4-E : Using the UPPER, LOWER and PROPER Functions

You may want to convert text from uppercase to lowercase or from lowercase to proper case to make it more readable. To change the case of text, use the UPPER, LOWER, or PROPER functions.

Syntax:

UPPER(text)    Changes text to all uppercase.
LOWER(text)  Changes text to all lowercase.
PROPER(text) Changes text to title case.

text    is the text you want converted to uppercase. Text can be a reference or text string.

Examples:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>=UPPER(A2)</td>
<td>=LOWER(A2)</td>
<td>=PROPER(A2)</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>joe Smith</td>
<td>JOE SMITH</td>
<td>joe smith</td>
<td>Joe Smith</td>
</tr>
</tbody>
</table>
For more information on Excel, the following sources are recommended:

- Try the Help menu built into Microsoft Excel.

- Use the free online training and Quick Reference guide for Excel available from Microsoft: http://office.microsoft.com/excel

  Take free, online Excel training courses: http://office.microsoft.com/training

  Once at the above Web page, from the **Browse Training Courses** section, select **Excel**. “Get to know Excel: Enter formulas” and “Find functions and enter arguments” are two examples you will find in the Excel Courses listing.